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Last Time

Shape Primitives: Shapes included in Processing as a
building block for more complex shapes.

point
triangle
ellipse
rect
arc
bezier

Locations described in screen space (a.k.a.
the screen coordinate system). 2



Code Review
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There are two kinds of code:

Code that "makes a thing available".
Code that "actually does a thing".

float hello;
PImage myImg;
float myDouble(float x){
  return 2*x;
}
 
hello = 3.0;
ellipse(2, 5, 10, 50);
fill(20, 30, 50);
myDouble(hello);
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If your code "does something", it needs to live
within setup() or draw().

If you're interested in why, find me during office hours. 5



Q: Why can't we write code outside of setup() and draw()?

Well....you kinda can. Processing offers a "static" mode where we can
write all our code at the top level. But once we do this, we can no longer

write any functions, and we lose the ability to run code repeatedly.

// This Processing program compiles and runs
String s = "The size is ";
int w = 1920;
int h = 1080;
println(s);
println(w, "x", h);
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The setup()/draw() separation is initially confusing,
but much more powerful in the long run.
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Processing?

Will this language be easy to learn in?

Yes*. What will we be able to do by the end of
this class?

*terms and conditions apply

Work with 2D and 3D scenes which move,
are interactive, and use data stored on the
computer. Basic games, data visualization,
and short animations are all on the table.

Why is Processing considered a
simple language?
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import { CanvasAnimation } from "../lib/webglutils/CanvasAnimation.js"; 
import { GUI } from "./Gui.js"; 
import { Mat4, Vec4, Vec3 } from "../lib/TSM.js"; 
import { Easel } from "./Easel.js"
import { Scene } from "./raytracer/scene.js"; 
import { Sphere } from "./raytracer/SceneObjects/sphere.js"; 
import { Transform } from "./raytracer/transform.js"; 
import { Material } from "./raytracer/material.js"; 
 
export interface RaytracerTest { 
  reset(): void; 
  draw(): void; 
} 
 
export class Raytracer extends CanvasAnimation { 
  private gui: GUI; 
  private gl: WebGLRenderingContext; 
  private easel: Easel; 
  private scene: Scene; 
  private sceneLoaded: boolean; 
 
  public constructor(canvas: HTMLCanvasElement) { 
    super(canvas); 
    this.gl = this.ctx; 
    this.gui = new GUI(canvas, this); 
    this.scene = new Scene(); 
    this.sceneLoaded = true; 
    this.reset(); 
  } 
 
  public draw(): void { 
    this.easel.render(); 
  } 
 
 
  public reset(): void { 
    const t = Transform.fromTranslate(new Vec3([0, 0, -4])); 
    this.scene.shapes.push(new Sphere(this.scene, new Material(), t)); 
 
    this.easel = new Easel(this.gl, 512, 512); 
    this.easel.setDefaultAppearance(); 
  } 
} 
 
export function initializeCanvas(): void { 
  const canvas = document.getElementById("glCanvas") as HTMLCanvasElemen
  /* Start drawing */ 
  const canvasAnimation: Raytracer = new Raytracer(canvas); 
  canvasAnimation.start(); 
}

import { 
  CanvasAnimation, 
  WebGLUtilities 
} from "../lib/webglutils/CanvasAnimation.js"; 
import { 
  vsSource, 
  fsSource 
} from "./Shaders.js"; 
import { Vec3 } from "../lib/TSM.js"; 
 
// A class for storing image data and drawing the image to the screen
export class Easel { 
  public render(): void { 
    this.gl.clearColor(0.0, 0.0, 0.0, 1.0); // Clear to black, fully opaque 
    this.gl.clearDepth(1.0); // Clear everything 
    this.gl.clear(this.gl.COLOR_BUFFER_BIT | this.gl.DEPTH_BUFFER_BIT); 
 
    this.gl.bindBuffer(this.gl.ARRAY_BUFFER, this.vertexBuffer); 
    this.gl.vertexAttribPointer(this.vertexPosAttribLoc, 2, this.gl.FLOAT, false, 0, 0); 
    this.gl.enableVertexAttribArray(this.vertexPosAttribLoc); 
 
    this.gl.bindBuffer(this.gl.ARRAY_BUFFER, this.textureBuffer); 
    this.gl.vertexAttribPointer(this.vertexTexCoordAttribLoc, 2, this.gl.FLOAT, false, 0,
    this.gl.enableVertexAttribArray(this.vertexTexCoordAttribLoc); 
 
    this.gl.activeTexture(this.gl.TEXTURE0); 
    this.gl.bindTexture(this.gl.TEXTURE_2D, this.generateTexture()); 
    this.gl.uniform1i(this.uSamplerUniformLoc, 0) 
 
    this.gl.useProgram(this.program); 
    this.gl.drawArrays(this.gl.TRIANGLE_STRIP, 0, 4); 
  } 
 
  public reset(): void { 
    const nbytes = 3 * this.width * this.height; 
    this.data = new Uint8Array(nbytes); 
    this.texture = this.gl.createTexture(); 
 
    this.program = WebGLUtilities.createProgram(this.gl, vsSource, fsSource); 
 
    const vertices = new Float32Array([ 
      -1.0, 1.0,  // Top left 
      1.0, 1.0,  // Top right 
      -1.0, -1.0,  // Bottom left 
      1.0, -1.0,  // Bottom right 
    ]); 

 
    const textureCoordinates = new Float32Array([ 
      0.0, 0.0, 
      1.0, 0.0, 
      0.0, 1.0, 
      1.0, 1.0, 
    ]); 
 
    this.vertexBuffer = this.gl.createBuffer(); 
    this.gl.bindBuffer(this.gl.ARRAY_BUFFER, this.vertexBuffer); 
    this.gl.bufferData(this.gl.ARRAY_BUFFER, vertices, this.gl.STATIC_DRAW); 
 
    this.textureBuffer = this.gl.createBuffer(); 
    this.gl.bindBuffer(this.gl.ARRAY_BUFFER, this.textureBuffer); 
    this.gl.bufferData(this.gl.ARRAY_BUFFER, textureCoordinates, this.gl.STATIC_DRAW); 
 
    this.vertexPosAttribLoc = this.gl.getAttribLocation(this.program, "aVertexPosition"); 
    this.vertexTexCoordAttribLoc = this.gl.getAttribLocation(this.program, "aTextureCoord"); 
    this.uSamplerUniformLoc = this.gl.getUniformLocation(this.program, "uSampler"); 
  } 
 
  /// Set appearance to a polictical compass meme template 
  public setDefaultAppearance(): void { 
    const lightRed = new Vec3([1.0, 0.5, 0.5]); 
    const lightBlue = new Vec3([0.5, 0.5, 1.0]); 
    const lightGreen = new Vec3([0.5, 1.0, 0.5]); 
    const lightPurple = new Vec3([1.0, 0.5, 1.0]); 
    for (let y = 0; y < 512; y++) { 
      for (let x = 0; x < 512; x++) { 
        if (x < 256 && y < 256) { 
          this.setColor(x, y, lightRed); 
        } else if (x >= 256 && y < 256) { 
          this.setColor(x, y, lightBlue); 
        } else if (x < 256 && y >= 256) { 
          this.setColor(x, y, lightGreen); 
        } else { 
          this.setColor(x, y, lightPurple); 
        } 
        if (x == 256 || y == 256) { 
          this.setColor(x, y, new Vec3([0.0, 0.0, 0.0])); 
        } 
      } 
    } 
  } 
}

export const vsSource = ` 
    attribute vec4 aVertexPosition; 
    attribute vec2 aTextureCoord; 
    varying highp vec2 vTextureCoord; 
 
    void main(void) { 
      vTextureCoord = aTextureCoord; 
      gl_Position = aVertexPosition; 
    } 
  `; 
 
export const fsSource =  ` 
    varying highp vec2 vTextureCoord; 
 
    uniform sampler2D uSampler; 
 
    void main(void) { 
      gl_FragColor = texture2D(uSampler, vTextureCoord); 
      // gl_FragColor = vec4(vTextureCoord.x, vTextureCoord.y, 0.0, 1.0); 
      // gl_FragColor = vec4(1.0, 0.6, 0.4, 1.0); 
    } 
`; 
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Many of the basic ideas that we find in Processing exist
in these "more complex" languages!

One example: the above code has a function called draw().
This function is called 60 times per second by the JavaScript

library responsible for the screen layout.
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Béziers are Silly!
Okay, yes. Working with Bézier curves the way Processing has

you do it is an exercise in pain and futility.

But pair it with a graphical interface or a way to
programmatically generate these control points...

class ControlPoint {
  PVector location;
  color c;
  float r = 30;
  
  ControlPoint(float x, float y, color c_) {
    location = new PVector(x, y);
    c = c_;
  }
 

id d {
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Do circular screens use polar coordinates?

It depends....but usually no.
11



Lightning Round!
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How can I make two different files
with draw() and setup() methods?

Processing distinguishes between "projects" which consist
of multiple files in the same directory, and actual files.

Files within the same project can interact with each other.

If you want new code to not interact with anything you've
already written, you need a new project (File > New). This will

open a new Processing window.
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If we're absent, are hands-on assignments still due at 7:30?

Yes. Contact me if this will be a problem.

Can we work on the hands-on assignments ahead of time?

I would prefer you didn't, but I can't stop you.
 

All lecture slides that I have not covered yet are considered
non-final. This includes the hands-on assignments.
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Attributes
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Attributes

Function calls which modify the appearance of
shape primitives
Apply to all primitives displayed after the
attribute
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Attributes: Fill and Stroke

background() sets the background color of
the screen
 
fill() sets the fill color for a shape
 
stroke() sets the outline color for a shape
 
noFill() and noStroke() prevent shape
fill or shape stroke respectively
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int WHITE = 255;
int BLACK = 0;
 
fill(WHITE);
stroke(BLACK);
rect(0, 0, 50, 50);
 
fill(BLACK);
stroke(WHITE);
rect(50, 50, 50, 50);
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Modes

Function calls which modify the
interpretation of shape primitive
functions
 

Apply to all primitives displayed after the
mode
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Modes for rect and ellipse

rectMode() and ellipseMode() take a parameter:
CORNER, CORNERS, CENTER, RADIUS

These parameters change how the parameters to calls
to rect() and ellipse() are interpreted.

20



rectMode(CORNER);
rect(a, b, c, d);

(a,b)

c

d

rectMode(CORNERS);
rect(a, b, c, d);

(a,b)

(c,d)

rectMode(CENTER);
rect(a, b, c, d);

rectMode(RADIUS);
rect(a, b, c, d);

(a,b)

c

d
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Other Modes
Modes allow for different models within the context of the

same method.
Other modes in Processing:

colorMode
textureMode
imageMode
shapeMode
blendMode
textMode
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Order Matters!
Attribute and mode commands only affect the
commands that come after them. Ordering of

statements is important!

stroke(100);
rect(80, 120, 150, 40);
stroke(200);
rect(50, 100, 150, 40);
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Order Matters!
The order of draw commands can also affect

output!

rect(50, 100, 150, 40);
rect(80, 120, 150, 40);

1
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rect(80, 120, 150, 40);
rect(50, 100, 150, 40);

1
2
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Order Matters Globally
int WHITE = 255;
int BLACK = 0;
 
fill(WHITE);
stroke(BLACK);
rect(0, 0, 50, 50);
 
drawRect(0, 0, 100, 100);
 
// What color does this draw in?
rect(100, 100, 100, 100);
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void drawRect(int a, int b, 
              int c, int d){
  fill(BLACK);
  stroke(BLACK);
  rect(a,b,c,d);
}
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Hands-on: Using Attributes
1. Experiment with stroke(), fill(), noStroke(), and
noFill().

2. Draw a rectangle and an ellipse and then try out at least one
alternate mode on these shapes.

3. Experiment with the order of attribute/mode/draw calls.
Create at least two shape clusters which demonstrate a
difference in order.

4. Answer the following questions in a block comment:
1. How can order create the illusion of depth?
2. How can primitive modes help us build images?
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Color
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Additive vs Subtractive
R G B R G B R

+ =
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Note: this isn't quite true! c.f. "Color is a mess"

YGR



RGB CYM(K)
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Digital Color

Each pixel has three light elements:
red, green, and blue.

Light element intensity ranges from 0
to 255

0 means element is off
255 means element is max

What color model is this? 31



Colors!
Red: 255, 0, 0
Green: 0, 255, 0
Blue: 0, 0, 255

Colors at full intensity can be a little much!
Processing includes a color selector for more
intuitive color selection if you don't have
access to a digital paint program (Tools >
Color Selector)
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Hexadecimal
A popular notation for writing down RGB colors. Each

number 0-255 is encoded as a two-digit hex.

#bf5700

191,87,0

Hey, what color is this anyways?
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"True Color"
Three 8-bit channels (RGB) makes for a

24-bit color space. Sometimes add a
4th channel for transparency (RGBA).

Allows us to represent 16,777,216
different colors. Humans can see

around 10 million colors.
Does not actually cover all colors

humans can see!
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Color and Space Costs
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How many values can a bit store?
How many values can two bits store?
How many values can three bits store?
How many bits do we need to store 255
values?
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Images are expensive!
For true color, we store 8 bits of information per color (0-255), or

24 bits per pixel.

How much data do we need for a 1080p60 video?

24 ×
pixel
bits

1920 × 1080 ×(
frame
pixel ) 60 =

second
frames

2,985,984,000 bits/second

370 megabytes per second!

How can we tame the amount of data we need to
store images?
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Color Depth
Use different number of bits to store color data! If we only use 8 bits

per pixel, we can store 1/3rd the data relative to true color.

True Color (24 bits) 38



12-bit Color
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9-bit Color
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Image Formats
Various image formats have different color and transparency depths.

GIF
Color depth: 1-bit to 8-bit
Transparency: 1-bit

JPEG
Color depth: 24-bit
Transparency: None

PNG
Color depth: 1-bit to 24-bit
Transparency: 8-bit
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Processing and Blending
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There are functions in Processing that allow us
to set colors.

background(int red, int green, int blue) sets the
color of the window in terms of RGB
fill(int red, int green, int blue) sets the color for
any subsequent shape primitives
fill(int red, int green, int blue, int alpha)
includes a transparency channel to modify opacity
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The color primitive
Processing has a special type for color:

color(float red, float green, float blue);

We can store it and use it in functions that expect color.

color yellow = color(255.0, 255.0, 0.0);
fill(yellow);
rect(0, 0, 200, 200);
 
// Processing also accepts color hexes!
color burnt_orange = #bf5700;
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An aside

void draw(){
   background(255,0,0);
   background(0,255,0);
   background(0,0,255);
}
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What is this code trying to do?

Why do we never do this?
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Transparency
Transparency (alpha) also ranges from 0 to 255
Allows for on-screen color mixing based on the
blend mode.
Default mode is blendMode(BLEND)

What operation is
happening here? It isn't an

add...
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Hands-on: Using Color
1. Store some color primitives in an array for re-use (make at

least 4 colors). Use the color picker (Tools > Color Selector) if
you don't have any ideas off the top of your head.
 

2. Incorporate several of your color primitives into shapes
using fill() and stroke().
 

3. Use blendMode() to affect color interactions with
transparent colors. Show at least one example of how a
different blendMode() can result in a different behavior.
Remember that mode calls only affect the draws that occur
after them!
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Index Cards!
1. Your name and EID.

 
2. One thing that you learned from class today.

 
3. One question you have about something covered in

class today.
 

4. (Optional) Any other comments/questions/thoughts
about today's class.

It's okay if you didn't learn anything, but you must ask a
question.
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